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DIABLO ANALYTICAL, INC. SOFTWARE LICENSE AGREEMENT AND LIMITED WARRANTY

LICENSE AGREEMENT

IMPORTANT:  Please carefully read the License Agreement below before installing the software.  The right to use this 
software product is sold only on the condition that the customer agrees to the following license.  INSTALLING THE 
SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS.

In return for payment of the one-time license fee for this software product, Customer receives from Diablo Analytical, 
Inc. (Diablo) a license to use the product subject to the following terms and conditions:

Use:  The product may be used one computer or workstation.  A separate license agreement and fee is required for each 
additional computer or workstation on which the product is used.  Customer may not reverse assemble, decompile, or 
modify the software.

Copies:  The software product may not be duplicated or copied except for archive purposes, program error verification, 
or to replace defective media, and all copies made must bear the copyright notices contained in the original.

Ownership:  Purchase of this license does not transfer any right, title or interest in the software product to Customer 
except as specifically set forth in this License Agreement.  Customer is on notice that the software product is protected 
under copyright laws.

Transfer of  Rights:  This license and the software product may be transferred to a third party, with prior written consent 
from Diablo, provided the third party agrees to all the terms of this License Agreement and the Customer does not retain 
any copies of the software product.

Sublicensing and Distribution:  Customer may not sublicense the software or distribute copies of the software to the 
public in physical media or by telecommunication without the prior written consent of Diablo.

Termination:  Diablo reserves the right to terminate this license upon breach.  In event of termination, Customer will 
either return all copies of the product to Diablo, or with Diablo's prior consent, provide Diablo with a certificate of 
destruction of all copies.

Updates and Upgrades:  Customer agrees that the software does not include updates and upgrades which may be 
available from Diablo in a separate support agreement.

Export Restrictions:  Customer agrees not to export or re-export the software or any copy in violation of the U.S. Export 
Administration regulations or other applicable regulation.

LIMITED WARRANTY

Limited Warranty:  Diablo warrants that the original disks are free from defects for 90 days from the date of delivery of 
the software.

No Other Warranties:  To the maximum extent permitted by applicable law, Diablo expressly disclaims any warranty for 
the software product.  The software product and any related documentation is provided "as is" without warranty of any 
kind, either express or implied, including, without limitation, the implied warranties or merchantability of fitness for a 
particular purpose.  The entire risk arising out of use or performance of the software product remains with the customer.

Limitation of Liability and Customer Remedies:  Diablo's entire liability and the customer's exclusive remedy under this 
license agreement shall be, at Diablo's option, either (a) return of the price paid for the software or (b) replacement of the 
software that does not meet Diablo's Limited Warranty and which is returned to Diablo with a copy of the customer's 
receipt.  Any replacement software will be warranted for the remainder of the original warranty period, or 30 days, 
whichever is longer.  These remedies are not available outside the United States of America.



No Liability for Consequential Damages:  To the maximum extent permitted by applicable law, in no event shall Diablo 
be liable for any damages whatsoever (including, without limitation, damages for loss of business profit, business 
interruption, loss of business information, or any other pecuniary loss) arising out of the use or inability to use the 
product, even if Diablo has been advised of the possibility of such damages.  Because some states/jurisdictions do not 
allow the exclusion or limitation of liability for consequential or incidental damages, the above limitation may not apply 
to you.



  Diablo BTU Calculator and Reporting Software 3.0 Contents    v

Contents

Introduction 1

BTU Calculator and Reporting Software Overview.................................................................. 1
System Requirements ................................................................................................................ 2
Installing the Software............................................................................................................... 2
Software License and Registration ............................................................................................ 3
Technical Support...................................................................................................................... 3
BTU Calculations ...................................................................................................................... 4

Disclaimer ................................................................................................................... 4
Rounding..................................................................................................................... 4
Water Calculations ...................................................................................................... 4
Disabling BTU Calculations ....................................................................................... 5
Resources .................................................................................................................... 5

Getting Started 7

The Sample Results Window .................................................................................................... 7
The Parameter Monitor Window............................................................................................... 8
The Parameter History Window................................................................................................ 9
Quick Start Instructions ........................................................................................................... 10

Load and Edit the Configuration File........................................................................ 10
Specify Other Calculation Parameters ...................................................................... 12
Set the Report Preferences ........................................................................................ 12
Set the Data File Preferences .................................................................................... 12
Automatic Processing from the Agilent Cerity Data System .................................... 12
Automatic Processing from the Agilent EZChrom Data System .............................. 13

Running the Software 14

The Main Menu ....................................................................................................................... 14
File Menu .................................................................................................................. 14
Tools Menu ............................................................................................................... 15
Help Menu................................................................................................................. 15

Configuring the Software ........................................................................................................ 15
Managing Configuration Files .................................................................................. 15
Components .............................................................................................................. 16
Standard Component Physical Properties ................................................................. 18
Other Factors............................................................................................................. 19
Report........................................................................................................................ 21
Data Files .................................................................................................................. 22
Sample Info ............................................................................................................... 23
Data Export ............................................................................................................... 25
Parameter Options..................................................................................................... 27

Using Monitored Parameters and History Plots ...................................................................... 31
The Parameter Monitor ............................................................................................. 31
Parameter History...................................................................................................... 32



vi    Contents   Diablo BTU Calculator and Reporting Software 3.0

Manual Data Processing and Reporting .................................................................................. 34
Automatic Data Processing and Reporting.............................................................................. 34

The Agilent Cerity Data System ............................................................................... 34
Agilent Technologies EZChrom Data System .......................................................... 36

Appendix 40

BTU Data File Format............................................................................................................. 40
Export Template Format.......................................................................................................... 41

Summary of Export Template Variables................................................................... 44

Index 51



  Diablo BTU Calculator and Reporting Software 3.0 Introduction    1

Introduction

BTU Calculator and Reporting Software Overview

The Diablo Analytical BTU Calculator and Reporting Software

The Diablo BTU Calculator is a simple, easy-to-use, yet flexible BTU Calculating 
and Reporting Software solution.  Here are a few of the key features of the software:

BTU Calculating and Reporting Features

 Calculates Dry/Saturated/Wet Gross Heating Value, Real Relative 
Density, Gas Compressibility factor and GPM value from un-
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normalized component mole% values using GPA 2172-96 and ASTM 
D3588-98 (2003) standard calculations.

 The component list is completely customizable.  Components can be 
added to or deleted from the component list, and calculation factors 
(Heating Value, Molar Mass Ratio, Summation Factor, and GPM 
Volume Factor) can be updated by the user as needed.  Standard 
component physical property tables are provided for the GPA 2145-03 
and GPA 2145-09 Standards, and the GPSA Engineering Data Book 
(12th Edition, 2004).

 The component list can be configured so that mole% results from other 
analyzers (e.g. water analyzer, H2S by Draeger Tube, etc.) can be 
entered manually for specified components and included in the 
calculations.

 Results can be exported to a text file for transfer to Laboratory 
Information Management System.  The format of the text file can be 
easily customized using the BTU Calculator’s flexible Export 
Templates.

 Allows completely automated post-run processing of data from the 
Agilent Technologies Cerity data system. The software can be 
configured to print a report and/or save the results to a comma-
delimited text file automatically after processing the results from 
Cerity.

 Allows completely automated post-run processing of data from the 
Agilent Technologies EZChrom Elite or EZChrom SI data systems.

General Parameter Monitoring Features

 The BTU calculations can be disabled if you want to use the software 
only for general reporting, monitoring, and exporting of EZChrom and 
Cerity analysis results.

 You can set up both component and calculated results as monitored 
parameters that are displayed in a separate monitoring window.  You 
can set both high and low alarm limits for those monitored parameters.

 You can plot the historical value of any of the monitored parameters.  
The trend plot can be printed, copied to the Windows clipboard, and the 
historical data can be exported to a comma-delimited text file.

System Requirements
The software is designed for operation under the Microsoft Windows 2000 and 
Windows XP Professional operating systems.  Automated processing of results 
requires the Agilent Technologies Cerity data system (Version 4.0.5 or Version 
4.0.7), or the Agilent Technologies EZChrom Elite or EZChrom SI data systems.

Installing the Software
To install the software, simply run the installation program that was downloaded 
from our web site or provided on the installation CD-ROM.  Follow the directions 
presented by this installation program.  Unless you have purchased a site license, the 
installation program will install the Diablo BTU Calculator in trial mode on new 
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systems, or will update registered systems to the latest version of the Software.

Important: Important:  Under Windows NT 4.0, Windows 2000, and Windows XP, you must 
be logged in with Administrator privileges in order to install the software.

Important:  Any users who will be running the software under a non-administrator 
account must have full read/write permissions to the BTU Calculator directories and 
files.  The installation program grants these rights to the “Everyone” user group.  
However, if the “Everyone” user group is disabled on the network, then you will 
have to grant these permissions manually.

If you will be using the BTU Calculator Software with the Agilent Technologies 
EZChrom Elite or EZChrom SI data systems, make sure to select the “Complete 
Setup” option when the installer displays the “Choose Setup Type” window (this is 
the default setup type).

Software License and Registration
Unless you have purchased a site license, this software is distributed as a fully 
functional 30-day evaluation application.  The evaluation version has all of the 
features of the registered version, but you will be reminded that you are running the 
evaluation version with a “nag” screen each time you start the application.  At the 
end of the 30-day evaluation period the application will no longer start unless you 
purchase a license or request an evaluation extension from Diablo Analytical.

Technical Support
The Diablo BTU Calculator software was written and is supported by:

Diablo Analytical, Inc.
5141 Lone Tree Way
Antioch, CA  94531

Phone:  (925) 755-1005
Fax:    (925) 755-1007

Phone

If you want to speak directly with technical support, call us at (925) 755-1005.

Fax

Fax a description of your problem or suggestion to us at (925) 755-1007.

Electronic Mail

Use our dedicated support address for e-mail based technical support: 
support@diabloanalytical.com

World Wide Web

Use our web-based help desk to submit and track support requests:  
http://www.diabloanalytical.com/support.htm

mailto:support@diabloanalytical.com
http://www.diabloanalytical.com/support.htm
http://www.diabloanalytical.com/support.htm
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BTU Calculations
BTU calculations are based on the GPA 2172-96 Standard and the ASTM D3588-
98(2003) Standard.  The physical properties used in the calculations can be chosen 
and/or modified by the user.  However, the software includes example configuration 
files and standard component tables from the GPA 2145-03 and GPA 2145-09 
Standards.

Important: Important:  If you upgrade or re-install the BTU Calculator Software, all of the 
default configuration files will be overwritten with the current versions.  
Consequently, if you use any of the default configuration files as the basis for a 
custom configuration, make sure to save your configuration file with a different file 
name.

Disclaimer

Important: Important:  It is the customer’s responsibility to ensure that the physical properties 
and other settings in the BTU Calculator configuration generate results that are 
correct for their application.

The choice of which physical property values to use is a business decision that can 
only be determined by you and your use of the data and results.

Please review the License Agreement and Limited Warranty displayed at the 
beginning of the printed manual for Diablo’s limits on liability.

Pressure Base

All of the default configuration files use a Pressure Base of 14.696 or 14.73 psia.  It 
is the customer’s responsibility to determine the correct Pressure Base to use for their 
specific requirements.  Note that the North American Energy Standards Board 
(NAESB) specifies a standard pressure base of 14.73 psia.  Consequently many 
companies are adopting 14.73 as the standard pressure base for these calculations.

Rounding

Normalized mole percent values are rounded to the number of decimal places 
specified in the Data File Output Options setting of the configuration editor.  If 
rounding causes the total normalized mole% not to sum to 100%, then a correction is
made to the normalized mole% of the most concentrated component in the sample 
(usually methane) to force the total to 100%.

Water Calculations

If water exists as a component in the component list, then "Saturated" results will be 
calculated and reported along with the "Dry" results.  If the mole% of water is 
greater than 0, then "Wet" results will also be calculated based on that mole% value.

See “Components” on page 16 for more information on setting up the component list 
to include water, and “Other Factors” on page 19 for information on setting up 
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water-related calculation factors.

Important: Important:  All calculations assume that the compositional analysis was performed 
on a dry basis.  The component mole fractions from the dry analysis are corrected for 
the water mole fraction when performing the saturated and wet calculations.

Disabling BTU Calculations

The BTU calculations can be disabled if you want to use the software only for 
general reporting and exporting of EZChrom and Cerity analysis results.  See 
“Report” on page 21 for more information.

Resources

Gas Processors Association

6526 East 60th Street

Tulsa, Oklahoma  74145

Phone:   918-493-3872

Web:  www.gasprocessors.com

ASTM International

100 Barr Harbor Drive

PO Box C700

West Conshohocken, PA  19428-2959

Phone:  610-832-9585

Web:  www.astm.org
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Getting Started

The Sample Results Window
After starting the software, the following window is displayed.  This window shows 
the “Sample Results” tab containing the results of the last BTU analysis (but will be 
blank when the software is first started).

The “Sample Results” tab on the Main Screen of the Diablo BTU Calculator
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Sample Information

This section of the main screen contains the sample information that was passed to 
the software from the chromatography data system, or was entered by the user during 
manual processing.  You can also define custom sample information fields if you 
would like to include additional data in the report.  See “Sample Info” on page 23 for 
more information on this capability.

Note:  Blank sample information fields are not displayed in the sample Information 
table.

Component Summary

This section contains a summary of the individual component results as well as the 
total normalized mole% (should always be 100%), the total Gross Heating Value
(BTU / ideal cu. Ft.), the total Molar Mass Ratio (Ideal Relative Density), and the 
GPM value (gallons / 1000 cu. ft.).

Results Summary

The calculation results are displayed in this section of the main screen.  Results 
displayed include,

The Total Unnormalized Mole%

The Pressure Base used for the calculation

The Gross Heating Value (BTU / real cu. Ft.)

The Real Relative Density

The Gas Compressibility (Z) Factor

The Parameter Monitor Window
This window shows the Parameter “Monitor” tab that displays the results from the 
last analysis for any monitored parameters.  High and low alarm limits can be set up 
for each monitored parameter.  See “The Parameter Monitor” on page 31 for more 
information on this capability.
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The “Parameter Monitor” tab on the main screen of the Diablo BTU Calculator

The Parameter History Window
This window shows the Parameter History tab that can be enabled to plot the 
historical values of any of the monitored parameters.  See “Parameter History” on 
page 32 for more information on this capability.
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The “Parameter History” tab on the main screen of the Diablo BTU Calculator

Quick Start Instructions
The following instructions describe the key steps that should be performed when 
using the software for the first time.  You will find more detailed instructions in later 
sections of this manual.

Load and Edit the Configuration File

The first time you run the BTU Calculator you should configure the settings for your 
application.  To open the configuration editor, select the "Edit Configuration.." 
option of the "Tools" menu.  Additional information about configuring the software 
can be found in  "Configuring the Software" on page 15.  The default configuration 
files shipped with the software are listed in the following table.

Important Important:  If you upgrade or re-install the BTU Calculator Software, all of the 
default configuration files listed in this table will be overwritten with the current 
versions.  Consequently, if you use any of these default configuration files as the 
basis for a custom configuration, make sure to save your configuration file with a 
different file name.
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BTU Calculator Default Configuration Files

File Description

Default.cfg Contains a set of common components with calculation 
factors taken from GPA Standards 2145-09 and 2172-
96 (Hydrogen and Argon).  The Pressure Base is set to 
14.73 in this file.  This is the settings file that will be 
loaded when you first start the software.

Hexanes plus.cfg An alternate version of the default configuration file 
that contains the “hexanes+” component in place of 
hexane, heptane, and octane.  The calculation factors 
used for the hexanes plus component are based on a 
60:30:10 mixture of hexane, heptane, and octane.  The 
GPA 2145-09 Standard was used to calculate the 
Hexanes+ calculation factors.

GPA 2172-96.cfg Contains the components and factors used for the 
example calculations in the GPA 2172-96 standard.  
The Pressure Base is set to 14.696 in this file.

GPA 2172-96 Wet.cfg Same as above but includes Water as a component for 
Saturated/Wet calculations.

GPA 2145-03.cfg Contains the components and factors in the GPA 2145-
03 Standard.  The Pressure Base is set to 14.696 in this 
file.

GPA 2145-03 Wet.cfg Same as above but includes Water as a component for 
Saturated/Wet calculations.

GPA 2145-09.cfg Contains the components and factors in the GPA 2145-
09 Standard.  The Pressure Base is set to 14.696 in this 
file.

GPA 2145-09 Wet.cfg Same as above but includes Water as a component for 
Saturated/Wet calculations.

ASTM D3588-98 (2003).cfg Contains a sub-set of the components and factors in the 
ASTM D3588-98 (2003) standard.  The Pressure Base
is set to 14.696 in this file.

ASTM D3588-98 (2003) Wet.cfg Same as above but includes Water as a component for 
Saturated/Wet calculations.

The software uses the settings file "Default.cfg" when first started.  However, you 
can use the "Load" button to choose the settings file that contains the components 
and factors that most closely match your application.  You can then add/delete 
components and adjust factors as needed.

Important: Important:  The order of the components in the component settings table is the 
order that they will be printed in the BTU report.  You can easily rearrange the 
component order by first selecting a component's row in the table by left clicking on 
that row with the mouse.  Next, while the cursor is still pointing to that row, click 
and hold the right mouse button and drag the component to a new location in the 
table.  The row being moved will be highlighted in red.  Release the right mouse 
button when the component is located at the desired position in the table.
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Specify Other Calculation Parameters

Make sure to set the Pressure Base to the correct value for your location.

Set the Report Preferences

Modify the report titles as desired.  In addition, check "Print report for automatically 
processed results" if you would like a report to be printed automatically when the 
software generates a BTU report upon receiving a request from the Agilent Cerity or 
EZChrom data system.  The report will be printed to the default printer.

Set the Data File Preferences

Specify the directory into which you would like to save BTU data files – use the 
"Browse" button to select or create the desired directory.

Automatic file saving

Check this box if you would like to have a data file created in the default data 
directory during automatic processing of data from the Agilent Cerity or EZChrom 
data system.  The data files are named using a date + time format:

YYYYMMDD-HHMMSS.BTU 

Where YYYYMMDD is the current date and HHMMSS is the current time (e.g. 
20050208-153423.BTU).

File Naming Options

Check this box if you would like to have the sample name added to the Date+Time
formatted file name during automatic processing.  If you enable this option, then you 
can also choose whether to add the sample name before (e.g. NGA Sample-
20050208-153423.BTU) or after (e.g. 20050208-153423- NGA Sample.BTU) the 
file name.

Automatic Processing from the Agilent Cerity Data 
System

Important: Important:  In order to process results from the Agilent Technologies Cerity data 
system, you must first make sure that the names in the component settings table 
exactly match the compound names in the Cerity calibration table.  For example, if a 
compound is named "Hexane" in the Cerity calibration table, it must also be entered 
as "Hexane" in the BTU component settings table (not "n-Hexane", or "nC6").

In order to have a BTU report generated automatically from Cerity after a run, you 
must edit the Cerity method by checking the "Post-Run Program" box in the "Run 
Programs" section of the Cerity Method screen (see the screen shot below).  You 
must then place the following command exactly as shown below in the associated 
text box:

<DiabloBTU.ProcessCerityData>
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Screen shot of the Agilent Cerity Method screen configured to run the Diablo BTU Calculator 
automatically after each run.

If you have checked "Print report for automatically processed results" in the BTU 
Calculator settings, then a report will automatically be calculated and printed after 
each Cerity analysis using this Method.  Similarly, if you have checked the "Save 
data file to default directory for automatically processed results" in the BTU 
Calculator settings, then a BTU data file will be saved automatically.

See "The Agilent Cerity Data System" on page 34 for more information about 
automatic processing and reprocessing of Cerity samples.

Automatic Processing from the Agilent EZChrom 
Data System

See “Agilent Technologies EZChrom Data System” on page 36 for information how 
to configure EZChrom and the BTU Calculator for automatic processing.
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Running the Software

The Main Menu
The Diablo BTU Calculator is configured and controlled using the following menu 
options:

File Menu

New Data File

Select this option to create a new data file and manually enter mole percent data.  See 
"Manual Data Processing and Reporting" on page 34 for more information.

Open Data File…

Select this option to open an existing BTU data file saved on disk.

Save Data File As…

Select this option to save the current data and results to a BTU data file.

Export Current Results

Select this option to export the current results to a text file using the settings 
specified in the Export section of the current configuration.

Load Configuration …

Select this option to load a configuration file from disk.  This is a shortcut to opening 
the configuration editor and pressing the "Load" button.

Print

This menu option allows you to print either the results that are currently displayed in 
the main screen (Print > Report), or the current settings being used by the software 
(Print > Current Settings).

The “Print > Report” menu option allows you to send the report to either the printer 
(Print > Report > Send to Printer) or save it to an Adobe PDF file (Print > Report > 
“Save as PDF).

The “Print > Parameter History Plot…” menu option allows you to print the trend 
plot and summary statistics for the parameter currently selected in the Parameter 
History window.

Print Setup…
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This option allows you to configure the printer.

Exit

This option immediately closes the software.

Tools Menu

Edit Configuration…

This option displays the BTU Configuration Dialog box.  See "Configuring the 
Software" on page 15.

Edit Current Data Set…

This option allows you to re-edit manually entered data sets.  It is not available when 
an automatically processed data set from the Cerity data system is loaded.  See 
"Manual Data Processing and Reporting" on page 34.

Show Export Template Variables…

Displays a table of the “variables” that can be used in an export template file.  See 
the Appendix for more information about Export Templates.

Help Menu

Help Contents…

Displays the contents page of the Diablo BTU Calculator help file.

View Release Notes

Opens the current release notes (readme.txt).  The release notes document the latest 
changes and enhancements to the software that may not have made it into this 
document.

GPA 2145-09 Migration Help…

Displays a special help file that describes procedures you can use to convert your 
existing BTU Calculator configurations so that they are using the GPA Standard 
2145-09 physical property constants.

License Status…

Displays the current license status of the Diablo BTU Calculator software.  This 
menu option is not displayed in versions of the software that were purchased under a 
site license.

About Diablo BTU Calculator…

Displays support and version information about the Diablo BTU Calculator.

Configuring the Software
The software is configured using the "Diablo BTU Configuration" dialog box, which 
is displayed by selecting the "Edit Configuration.." option of the "Tools" menu.  
Note that this dialog box is resizable.

Managing Configuration Files

You can Load and Save configuration files using the "Load and "Save" buttons.  The 
“Save As” button allows you to save the current configuration to a new file.  
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Configuration files are saved by default in the Diablo BTU Calculator installation 
directory.  You can also print a settings report using the "Print" button.

Important Important:  If you upgrade or re-install the BTU Calculator Software, all of the 
default configuration files will be overwritten with the current versions.  
Consequently, if you use any of the default configuration files as the basis for a 
custom configuration, make sure to save your configuration file with a different file 
name.

Components

The components "tab" of the configuration dialog is used to manage the list of 
components that will be included in the calculations and report.  You can either edit 
the component properties directly, or you can click the “Components” button to 
select from a list of standard components and their physical properties.  See 
“Standard Component Physical Properties” on page 18 for more information.

The "Components" Tab of the Diablo BTU Configuration Screen

Component Name

The component names entered in the components table will be displayed in the 
component summary tables and BTU report.

Important: Important:  If you are going to be processing data from the Agilent Cerity data 
system or the Agilent EZChrom data system, then you must make sure that the 
names in the component table match the names in the Cerity or EZChrom 
calibration/report exactly.  See "The Agilent Cerity Data System" on page 34 or 
“Agilent Technologies EZChrom Data System” on page 36.
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Component physical properties

Enter the following physical properties for each component.  Refer to published data 
sources such as GPA Standard 2145-03 or 2145-09.

Important: Important:  These physical properties should be ideal gas properties at 60 Degrees F 
and 14.696 psia.  Entering physical properties determined at different temperatures 
or pressures will result in incorrect calculations.

Molar Mass Ratio (G, Relative Density)

Gross Heating Value (Hv, BTU /cu. ft.)

Summation Factor (b)

Volume Factor (cu. ft. ideal gas / gallon liquid)

Manual Mole% Entry

Check this box if you are using the software to generate BTU reports automatically 
from the Agilent Cerity or EZChrom data system, and you need to be able to enter 
the specified component mole percent based on the results of a separate analysis.  

When the data from Cerity is processed, a dialog box will be displayed, allowing you 
to enter the component's unnormalized mole%, which will then be included in 
subsequent calculations.

Adding new components

Press the "Add" button to add a new row to the component table manually.  The row 
will be added below the currently selected row. Enter the component name and 
calculation factors for the new component.

Deleting existing components

To delete a component from the component list, select the row containing the desired 
component and press the "Delete" button".

Changing the component order

The order of the components in the component settings table is the order that they 
will be printed in the BTU report.  You can easily rearrange the component order by 
first selecting a component's row in the table by left clicking on that row with the 
mouse.  Next, while the cursor is still pointing to that row, click and hold the right
mouse button and drag the component to a new location in the table.  The row being 
moved will be highlighted in red.  Release the right mouse button when the 
component is located at the desired position in the table.

Clearing the table

Press the “Clear” button to delete all components from the component table.

Undoing changes to the component list

Press the “Undo” button to return the component list to the last saved configuration.
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Standard Component Physical Properties

Press the “Components” button on the Components tab of the configuration editor to 
display a table of standard components and their physical properties.

You can use the “Data Source” list box to display tables of standard physical 
properties from different data sources.  These data sources currently include the GPA 
2145-03 and 2145-09 Standards, and the extended component list from the GPSA 
Engineering Data Book (12 Edition, 2004).

You can also double-click on any cell in the table to transfer that particular value to 
the Windows Clipboard.  You can then paste that value into the component list.

Important: Important:  Physical properties for “Hexanes Plus” are calculated assuming a 
60:30:10 mixture of hexane, heptane, and octane.

After checking the components you want to add/update, click the “Transfer” button 
to transfer them to the component list.  If a component with the same name already 
exists in the component list, its physical properties will be updated to those from the 
table.  If there is no matching component with the same name, then the “Unknown 
Component” dialog box will be displayed.

Unknown Component Dialog Box

If you select a standard component whose name doesn’t match one of the existing 
entries in your component list, the “Unknown Component” dialog box is displayed.  
This dialog box gives you the option to either append the selected standard 
component to the end of your component list, or to copy the physical properties for 
the standard component to an existing component in your component list.  This 
allows you to update the physical properties for components that you may have 
named differently than the standard names (“CO2” vs. “Carbon Dioxide”, for 
example)
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The “Unknown Components” dialog box.

To update the physical properties for an existing component, select “Copy the 
properties to an EXISTING component”, and then choose the correct component 
name from the list box.  Click “OK” to transfer the standard physical properties to 
the selected component in your configuration.

You will have to repeat this process for each unknown component in your 
configuration file.

Other Factors

The "Other Factors" tab of the configuration dialog allows you to specify additional 
calculation factors. 

The "Other Factors" Tab of the Diablo BTU Configuration Screen
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Pressure Base

Enter the pressure base in psia to use for the calculations into this text box.  The 
calculated results will be corrected to reflect their values at the specified Pressure 
Base.

Note:  All of the default configuration files that ship with the EZReporter software 
use a Pressure Base of either 14.696 or 14.73 psia (14.696 psia for the configuration 
files that derive from a GPA or ASTM standard, and 14.73 psia for “default.cfg” and 
“hexanes plus.cfg”).  It is the customer’s responsibility to determine the correct 
Pressure Base to use for their specific requirements.  Note that the North American 
Energy Standards Board (NAESB) specifies a standard pressure base of 14.73 psia.  
Consequently many companies are adopting 14.73 as the standard pressure base for 
these calculations.

Air Summation Factor

The Air Summation Factor is used in the calculation of the real relative density.  The 
current value of this property as specified in GPA Standard 2145-03 is 0.00523 and 
in GPA Standard 2145-09 is 0.00537.

Water Settings for "Saturated" and "Wet" 
Calculations

These settings are used when calculating "Saturated" and "Wet" results when water 
is included in the component list.

Component Name:  If a component with this name exists in the component list, 
then "Saturated" results will be reported along with the "Dry" results.  If the mole% 
of this component in the analysis data is greater than 0, then "Wet" results will also 
be calculated based on that mole% value.

Important: Important:  The compound name in the component list must match this Water 
Component Name exactly.

Water Vapor Pressure:  The vapor pressure of water at 60 Deg. F:  0.25636 psia.

Internal Standard Amount Mapping

This is an advanced option that allows you to map the Internal Standard Amount 
from an EZChrom analysis to the raw mole% of one of the components.  This means 
that you can enter a result from another analyzer (e.g. H2S from a Draeger tube) into 
the EZChrom sequence, and have it automatically applied to the specified 
component without requiring reprocessing or prompting.

Important: Note 1:  EZChrom will switch the ISTD Amount from 0 or blank to 1 in the 
sequence table.  Consequently, you must enter a very small non-zero number for 0 
(for example 0.000001).

Note 2:  In order to enable this capability, you must configure EZChrom’s Advanced 
Method options to export a standard Sample Information Report file.  See 
“Configure EZChrom for Data Export” on page 36 for more information.
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Report

The "Report" tab of the configuration dialog allows you to customize the printed 
BTU report.

The "Report" Tab of the Diablo BTU Configuration Screen

Report Titles

You can customize the text that is printed on the BTU report – the title and subtitle 
as well as the header and footer.

Report Control

Check the “Print report for automatically processed results” box if you would like a 
report to be sent to the default printer when processing data automatically from the 
Agilent Cerity data system.

Disable BTU Calculations and Reporting

If you want to use the software for general reporting and exporting, you can disable 
BTU calculations by checking this check box under Report Control.

Important: Important:  The resulting report/results will not include any of the calculated BTU 
results – only the component retention time, peak area, raw (un-normalized) amount, 
and total raw (un-normalized) amount.  All other features of the software including 
exporting and monitoring, still work as normal.

Monitored parameters

Check the “Print parameter report” option if you would like to have a monitored 
parameter report printed along with the standard results report.  If you also check the 
“Report only parameters with failed alarms” option, then only those parameters 
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whose value has exceeded an enabled alarm limit will be included in the parameter 
report.

Data Files

The settings in the "Data Files" tab of the configuration dialog allow you to 
customize how BTU data files are handled.

The "Data Files" Tab of the Diablo BTU Configuration Screen

Default Data Directory

Specify the directory into which you would like to save BTU data files – use the 
"Browse" button to select or create the desired directory.

Automatic File Saving

Check this box if you would like to have a data file created in the default data 
directory during automatic processing of data from the Agilent Cerity or EZChrom
data systems. There are two options available for naming the BTU data files

Use EZChrom Data File name

If you choose this option, the BTU data file will be named based on the source data 
file name generated by the EZChrom data system.  The file will be named with the 
same base filename, but with the “.BTU” file extension instead of the “.DAT” file 
extension.

Auto-Generate BTU data file name

  The data files are named using a Date + Time format:

YYYYMMDD-HHMMSS.BTU 

Where YYYYMMDD is the current date and HHMMSS is the current time (e.g. 
20050208-153423.BTU).
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Auto-Generated Data File Naming Options

Check this box if you would like to have the sample name added to the Date+Time 
formatted file name during automatic processing (e.g. NGA Sample-20050208-
153423.BTU).

Sample Name Options

This option allows you to set whether the sample name is added before or after the 
file name.  Select “Before” (e.g. NGA Sample-20050208-153423.BTU) if you want 
the data files to sort alphabetically by sample name when you view the data file 
directory in Windows Explorer.  Select “After” (e.g. 20050208-153423-NGA 
Sample.BTU) if you want the data files to sort by the Date/Time.

File Format

This option sets whether the BTU data files are saved using a Comma or a Tab as the 
delimiter character between fields in the file.

Data File Output Options

Use this option to set the number of decimal places that will be reported for numeric 
results.  This setting is also used as the default number of decimal places for 
calculated numeric results in export files.  If “Apply to report” is checked, then 
calculated numeric results displayed in the report window will also be rounded to the 
specified number of decimal places.

Important: Important:  The normalized mole% values will be rounded to the number of 
decimal places specified in this setting before they are used in any calculations.  In 
addition, if rounding causes the total normalized mole% not to sum to 100%, then a 
correction is made to the normalized mole% of the most concentrated component in 
the sample (usually methane) to force the total to 100%.

Sample Info

These options allow you to enable and configure custom sample information fields 
that can be used to report additional conditions like well number, pressure, 
temperature, etc.  They are simply a way for the user to enter additional custom 
information during a BTU analysis, and have that information printed on reports and 
saved in the data and export files.
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The "Sample Info" Tab of the Diablo BTU Configuration Screen

Check the “Enable custom sample information fields” checkbox to enable the custom 
sample information fields.  Select the number of fields to display up to a maximum 
of 10, and then enter the captions for each of those fields.  These are the captions that 
will be displayed in the printed report, and when you are prompted to enter the 
associated custom sample information.  You can also specify whether the field is 
numeric.

Default Value

A default value can be specified for each of the custom sample information fields.  
The default value will be displayed automatically when the Sample Information 
dialog box is displayed.  However, if the “Recall” option is set and a previous value 
exists for the field, then the previous value will be displayed instead of the default 
value.

Numeric Sample Information Fields

If a sample information field is numeric, special numeric formatting and scaling can 
be applied to the value in the export file.  See “Data Export” on page 25 for more 
information.

Recall Last Value

Check the “Recall” check box if you would like the last value entered into this field 
to be recalled when the form is displayed.

Changing the order of Sample Information Fields

The order of the fields in the sample information table is the order that they will be 
printed in the BTU report and displayed in the sample information prompt.  You can 
easily rearrange the field order by first selecting a field's row in the table by left
clicking on that row with the mouse.  Next, while the cursor is still pointing to that 
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row, click and hold the right mouse button and drag the field to a new location in the 
table.  The row being moved will be highlighted in red.  Release the right mouse 
button when the field is located at the desired position in the table.

Entering custom sample information:

If you have enabled custom sample information fields, and if at least one of the fields 
contains a caption, then “Manual Data Entry” dialog box will be displayed when 
automatically processing the data from Cerity.  This dialog box will display the 
caption(s) specified in the Sample Info configuration, and allow the associated 
custom sample information to be entered by the user.  Alternatively, you can 
manually enter the sample information using the “Tools > Edit Current Data Set…” 
menu option.

The "Diablo BTU Manual Data Entry"dialog showing the custom sample information fields.

Data File Field Tags:

The following table lists the “tags” that are used to identify the custom sample 
information fields in the data file.

Field Data File Tag

1 SampleInfo1

2 SampleInfo2

3 SampleInfo3

4 SampleInfo4

. . . . . .

10 SampleInfo10

Data Export

The BTU Calculator software includes a flexible data export feature that allows you 
to create custom data export files in almost any format you might need.  An export 
template file defines the format of the export file.
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Export Configuration Panel

Export Options

Check “Create export file for automatically processed results” if you want the results 
from a Agilent Cerity or EZChrom analysis to be exported automatically when the 
data is processed by the BTU Calculator software.

Check “Append results if export file already exists” if you want the exported results 
to be appended to any results that already exist in the specified export file.  If this 
option is unchecked, then existing results will be overwritten.

Export Template File

Click the “Open” button to specify the template file that will be used to create the 
export file.  Click the “Notepad” button to open the selected export template file in 
Windows Notepad for editing.  See “Export Template Format” in the Appendix on 
page 41 for information on creating and editing Export Template files.  Note that 
several example template files are included with the software in the application 
installation directory.

Export Directory

Click the “Open” button to select the directory to which export files will be saved.

Export File

These options are used to specify the export file name.  You can choose to name the 
export file based on the name of the BTU data file, or you can enter a “fixed” file 
name.  If you choose the first option, the export file will have the same base file 
name as the BTU data file, but will have a “.TXT” file extension instead of the 
“.BTU” extension.
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You can also have the export file named based on the sample name.  This allows 
results from replicate runs of the same sample to be added appended to the same 
export file even though the data file names are different.

Show Template Variables

If you click this button, a table of supported template variables with descriptions will 
be displayed.  You can print this list by pressing the “Print” button.

Hint: Hint:  If you double-click on a particular variable, it will be copied to the Windows 
clipboard so that you can paste it into a template file.

BTU Calculator Template Variable Table

Parameter Options

The “Parameters” tab allows you to configure a list of component or calculated 
results that will be displayed in the “Parameter Monitor” window of the main 
software screen.  You can set both high and low alarm limits for these monitored 
parameters – if the parameter value exceeds either of these limits, the result will be 
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displayed with a red background in the parameter table to alert you.

The Monitoring configuration panel

Options:  Clicking the “Option” button displays theMonitoring Options dialog box.  
See “Setting Monitored Parameter Options” below for more information.

Add:  Clicking the “Add” button allows you to configure and add a new parameter 
to the monitored parameter table.  See “Adding or Editing Monitored Parameters” 
below for more information.

Edit:  Clicking the “Edit” button allows you to edit the options for the parameter that 
is currently selected the parameter table.  You can also double-click the desired row 
in the table to edit a parameter’s options.  See “Adding or Editing Monitored 
Parameters” below for more information.

Delete:  Clicking the “Delete” button will remove the selected parameter from the 
parameter table.

Clear:  Clicking the “Clear” button will clear the parameter table.

Undo:  Clicking the “Undo” button will restore the parameter table to the last saved 
configuration.

Help:  Clicking the “Help” button displays context-sensitive help for this topic.

Setting Monitored Parameter Options

Click the “Options” button to set additional options for the Monitor.  Currently the 
only additional option is the to set the size and bold/italics attributes of Monitor 
Display Font.

Display Font Tab

Use the “Size” list box and “Bold” and/or “Italic” check boxes to set the desired font 
for the Monitor Table.  A preview of the font is displayed for you.
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Parameter Monitor Options Dialog – Display Font Tab

History Plots Tab

Parameter Monitor Options Dialog – History Plots Tab

Enable Parameter History Plots:  Check this box to enable history plots for the 
monitored parameters.

X-Axis Data Source:  You can choose to plot the parameter values against a 
sequential data point/run number, or the current time when the report/results are 
generated.
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X-Axis Scroll Window: The X-Axis will automatically zoom to this time (in 
minutes) or data point window.  When new results are received, older data points 
outside this window will no longer be visible.  However, the entire history plot can 
be displayed at any time by clicking the “Zoom Full” button, or double-clicking on 
the plot window.

Y-Axis Scaling:  You can choose to have the y-axis scale adjusted automatically so 
that the range includes only the data points that are visible in the current 
plot/window.  Alternatively, you can choose to have the y-axis scale adjusted so that 
it represents the full range of parameter values, including those outside the current 
plot/window.

Important: Important Note:  If you have enabled either high or low alarm limits in the 
parameter configuration, then those limits will be displayed as red, dotted lines on 
the history plot.  Those alarm limits are included when determining the Y-axis range.

Adding or Editing Monitored Parameters

Click the “Add” button to add a new monitored parameter or the “Edit” button to 
edit the monitored parameter currently selected in the parameter table (you can also 
double click the line in the table that you want to edit).  You can also clear the 
current table by pressing the “Clear” button, or undo any changes you have made to 
the table by pressing the “Undo” button.

The Edit Monitored Parameter dialog

Display Name:  The text entered into the “Display Name” text box will be 
displayed for this parameter in the Monitor Table.  You can click the [<] button to 
copy text from the parameter and component (if appropriate) list boxes into the text 
box.
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Parameter:  Select the parameter that you want to monitor from this list box.  If 
you select a parameter that is derived from a component result (component amount, 
for example), then you will also need to specify the corresponding component from 
the component list box.

Component:  If you select a parameter that is derived from a component result 
(component amount, for example), then you will also need to specify the 
corresponding component from the component list box.

Format:  You can set the numeric formatting for the displayed parameter value by 
entering a format string in this text box.  Examples of common formatting strings are 
shown in the table below.

Format String Result

0 Will display all digits to the left of the decimal point and no digits to 
the right:

The value 10000.2324 will be displayed as 10000

The value 0.2324 will be displayed as 0

0.00 Will display all digits to the left of the decimal point and two digits 
to the right of the decimal place:

The value 232.4012 will be displayed as 232.40

The value 232 will be displayed as 232.00

0.0### Will display all digits to the left of the decimal place, and from 1 to 4 
digits to the right of the decimal place:

The value 232.4012 will be displayed as 232.4012

The value 232.4 will be displayed as 232.4

The value 232 will be displayed as 232.0

Common numeric formatting strings

Alarm Options:  You can enable both high and low monitoring alarms by checking 
either one or both of these check boxes and filling in the desired alarm level/limit. If 
the alarm is enabled and the parameter value exceeds the specified limit, the result 
will be displayed with a red background in the Monitor Table to alert you.  
Conversely, if the alarm is enabled and the parameter value does not exceed the 
limit, the result is displayed with a green background.

Enable History Plot for this parameter:  If you check this box, then the value 
of this monitored parameter will be plotted in the Parameter History display.  Note 
that you must first enable Parameter History Plots.  See Setting Monitored Parameter 
Options for more information.

Using Monitored Parameters and History Plots

The Parameter Monitor

Monitored parameters are displayed in a table on the “Parameter Monitor” tab of the 
main software screen.  The parameter table displays the results for monitored 
parameters from the last analysis or last data file loaded.

If either the high or low alarm is enabled for any of the monitored parameters, then 
the background color of the parameter value will be either red or green depending on 
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whether the actual value exceeds the enabled alarm limit.

Hint: Hint:  You can double click on the parameter table to quickly display the history plot 
of the selected parameter  (if history plots are enabled for the parameter).

The BTU Calculator Parameter Monitor Window

Parameter History

Historical values of monitored parameters can be plotted in the Parameter History 
window.

In order to display the parameter history window, you must enable parameter history 
plots in the main parameter options dialog.  In addition, you must also enable history 
plots for each individual parameter whose results you want to plot.  See “Parameter 
Options” on page 27 for more information.

The individual parameter history plots and summary statistics are displayed by 
clicking on the desired parameter display name in the parameter list.  If either high or 
low alarm limits have been enabled for a parameter, then the parameter name will be 
displayed with either a red or green background to indicate whether the current 
parameter value has exceeded an alarm limit (red background) or not (green 
background).  In addition, the alarm limit is displayed a s red, dotted line on the 
history plot.
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The “Parameter History” tab on the main screen of the Diablo BTU Calculator

Reset History:  Click the “Reset History” button to clear and reset the history plot 
and summary statistics for all plotted parameters.

Zoom Full:  Click the “Zoom Full” button to expand/contract the X and Y axes of 
the history plot to display the entire plot.  Double-clicking in the history plot window 
performs the same function.

Options:  Click the “Options” button to change the X-axis scroll window or Y-axis 
scaling mode:

Copy:  Click the “Copy” button to copy the currently displayed trend plot to the 
Windows clipboard.

Print:  Click the “Print button to print the currently displayed history plot and 
summary statistics.

Export:  Click the “Export” button to export the history results for all components 
to a comma-delimited text file.

Help:  Click the “Help” button to display context-sensitive help for this topic.
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Manual Data Processing and Reporting
It is possible to enter component mole% values manually and calculate results based 
on those values.  Select "New Data Set…" from the "file" menu.  Any existing 
results will be cleared from the main screen, and you will be presented with the 
Manual Data Entry dialog.  Enter the mole% values into the component table, and 
optionally a sample name, user name, and comments, and then press the "Process" 
button to perform the calculations.

Manual Data Entry Dialog Box

Important: Important:  Make sure to save these results to a BTU data file (select "Save Data 
Set As…" from the "File" menu) if you want to be able to recall the data at a later 
time.  You can print a BTU report by selecting "Print > Report" from the "File" 
menu.

You can re-edit the data you entered manually by selecting "Edit Current Data 
Set…" from the "Tools" menu.  Note however, that for purposes of data integrity, 
this option is disabled for data sets from the Agilent Cerity Data system that were 
automatically processed.

Automatic Data Processing and Reporting

The Agilent Cerity Data System

In order to have a BTU report generated automatically from Cerity after a run, you 
must edit the Cerity method by checking the "Post-Run Program" box in the "Run 
Programs" section of the Cerity Method screen (see the screen shot below).  You 
must then place the following command exactly as shown below in the associated 
text box:
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<DiabloBTU.ProcessCerityData>

Screen shot of the Agilent Cerity Method screen configured to run the Diablo BTU Calculator 
automatically after each run.

If you have checked "Print report for automatically processed results" in the BTU 
Calculator settings, then a report will automatically be calculated and printed after 
each Cerity analysis using this Method.  Similarly, if you have checked the "Save 
data file to default directory for automatically processed results" in the BTU 
Calculator settings, then a BTU data file will be saved automatically.

Important: Important:  In order to process results from the Agilent Technologies Cerity data 
system, you must first make sure that the names in the component settings table 
match the compound names in the Cerity calibration table.  For example, if a 
compound is named "Hexane" in the Cerity calibration table, it must also be entered 
as "Hexane" in the BTU component settings table (not "n-Hexane", or "nC6").

Reprocessing Cerity Samples

In order to reprocess an existing Cerity sample and have the results processed by the 
BTU Calculator, you must take the following steps:

1. Switch to the Cerity "Reprocess" tab, and select the desired sample from the 
sample list box.

2. Load the revision of the method that contains the Diablo BTU Calculator Post-
Run Program that you set up above:

Note that the most recent (top most) method revision will usually be the correct 
version to load.

3. If you have loaded the correct method, then the "Use Method's PostRun Program 
when Reprocessing" toolbar button (the blue circle with the white cross) will be 
enabled (not grayed out).  Click this toolbar button to enable the PostRun 
Program.
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4. Press the green arrow button to reprocess the sample.

Important: Important:  You will have to repeat these steps each time you select a new sample 
to reprocess.

Agilent Technologies EZChrom Data System

The Diablo BTU Calculator software supports automated processing of mole% 
results generated by the Agilent Technologies EZChrom Elite or EZChrom SI data 
systems.  This support is accomplished using the “Export” option of the EZChrom 
“Advanced Method Options”.  This option will export the analysis results to a 
delimited text file that can then be read and processed by the BTU Calculator 
Software.

Important: Important:  In order to process results from the Agilent Technologies EZChrom
data system, you must first make sure that the names in the component settings table 
match the compound names in the EZChrom calibration tables.  For example, if a 
compound is named "Hexane" in the EZChrom calibration table, it must also be 
entered as "Hexane" in the BTU component settings table (not "n-Hexane", or 
"nC6").

Configure EZChrom for Data Export

To configure EZChrom for data export to the BTU Calculator software, open the 
“Advanced Method Options” dialog box via the “Method > Advanced…” menu.  
Next, configure the “Export” tab as follows:

Important: Important:  Make sure to save the EZChrom method once you have made the 
following modifications.
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1. Click the “Export Enabled” box so that is checked.

2. Select “Standard Reports” from the list box.

3. In the “Parameters to export:” list, select “ESTD Report” and click the 
right/green arrow button so that “ESTD Report” appears in the “Export these 
parameters list on the right.

4. If you want to use the ISTD Amount Mapping feature of the BTU Calculator, 
you must also export the “Sample Information Report”.  See “Internal Standard 
Amount Mapping” on page 20 for more information on this feature.

5. Under “Export options”, select <comma> as the “Field separator”, and enter 
path to the directory where the export files will be made available to the BTU 
Calculator software.  This path must exist.

6. Important:  You must repeat these steps for each detector channel present in 
the method.  Use the detector channel list box located in the EZChrom toolbar to 
switch between channels:

After configuring the export parameters for each channel, switch to the “Files” tab of 
the Advanced Method Options, and configure it as follows:
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1. Under “User programs” check the “After export” checkbox.

2. Use the “file open” button to the right to select the 
ProcessEZChromData.exe “helper” program as the user program.

This program is located in the BTU Calculator software installation directory, 
which is usually “C:\Program Files\Diablo BTU Calculator\”.

3. In the “Additional parameters” text box, enter the export path that you entered 
for the export options above.

Important: Important:  If the export path contains any space characters, it must be enclosed in 
quotation marks.  For example,

“C:\Program Files\Diablo BTU Calculator\Export Files”

Exporting and Processing EZChrom Data

Once you have configured EZChrom as described above, the external standard 
export file(s) will be created each time a sample is analyzed or-reanalyzed.  After 
creating the export files, EZChrom will then run the “ProcessEZChromData.exe” 
program, passing it the path to containing the export directory.

The user program will check the export directory for any external standard (ESD) 
export files created by EZChrom.  If any are found it will read the sample 
information and component data and pass it to the BTU Calculator software for 
processing.
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The ProcessEZChromData status/log window

Important: Important Additional Notes:

1. It is best to start the Diablo BTU Calculator software before exporting and 
processing data from EZChrom.

2. If the user program successfully retrieves the results from EZChrom and the 
BTU Calculator software runs successfully, then the user program will close 
automatically.  However, if any errors occur, the user program will remain 
open to allow you to check the log window for information about the error.

3. If data processing is successful, any export files present in the export 
directory will be deleted automatically.
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Appendix

BTU Data File Format
BTU data files are comma-delimited text files that can be imported into LIMS or 
process data systems.  An example file is listed below.

Hint: Hint: Although the BTU data files are text files that can be used directly to send 
results to other customers or databases, Export files are a much better, more flexible 
way to do this.  See “Data Export” on page 25 for more information on Export 
Templates and Export Files.

SampleName,"GPA 2172-96 Example Calculation"

MethodName,""

UserName,""

Comments,"Gas properties at 60 Deg. F and 14.696 psia 
(Gas Analysis on Dry Basis)"

InjectionTime,""

SettingsFile,"D:\Diabprog\Diablo\Diablo BTU\App\GPA 
2172-96 Wet.cfg"

ProcessMode,3

DataSource,1

Instrument,""

SampleInfo1,"1456" (optional)

SampleInfo2,"82" (optional)

SampleInfo3,"" (optional)

SampleInfo4,"" (optional)

,,"Component","Ret.Time","Peak Area","Unnormalized 
Mole%","Normalized Mole%","Gross Heating Value","Molar 
Mass Ratio","Summation Factor"

Component,1,"Helium",0.000,0,0.03,0.03,0,0.00004146,0
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Component,2,"Nitrogen",0.000,0,0.32,0.32,0,0.003095136,0
.00001408

Component,3,"Carbon 
Dioxide",0.000,0,2.02,2.02,0,0.03069592,0.00039794

Component,4,"Methane",0.000,0,83.02,83.02,838.502,0.4598
64384,0.00963032

Component,5,"Ethane",0.000,0,7.45,7.45,131.84265,0.07734
59,0.00178055

Component,6,"Propane",0.000,0,4.39,4.39,110.45679,0.0668
4214,0.00151016

Component,7,"i-
Butane",0.000,0,0.83,0.83,26.99077,0.01665644,0.00038014

Component,8,"n-
Butane",0.000,0,1.08,1.08,35.23284,0.02167344,0.00051624

Component,9,"i-
Pentane",0.000,0,0.31,0.31,12.40279,0.00772272,0.0001801
1

Component,10,"n-
Pentane",0.000,0,0.25,0.25,10.02225,0.006228,0.00015775

Component,11,"n-
Hexane",0.000,0,0.3,0.3,14.2677,0.0089265,0.0002406

SumHV,1179.71779

SumMolarMass,0.69909204

SumZ,0.01480789

RawTotalMolePct,100

PressureBase,14.696

WaterMoleFractionSat,1.74442025040827E-02

GrossHeatingValueIdealDry,1179.71779

GrossHeatingValueRealDry,1183.53165556816

GrossHeatingValueIdealSat,1159.13855397357

GrossHeatingValueRealSat,1163.31848048984

RealRelativeDensityDry,0.701094431772844

RealRelativeDensitySat,0.700006424492229

GasCompressibilityFactorDry,0.996777555082519

GasCompressibilityFactorSat,0.996406894082425

Export Template Format
Export templates are plain-text files with a “.btx” file extension that are used to 
define how results will be saved to the text files created by the export feature of the 
BTU Calculator software.  Any text editor like Windows Notepad can edit export 
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template files.  However, make sure they are saved with the “.BTX” file extension 
(Notepad will sometimes append a “.TXT” file extension to the end of the “.BTX” 
extension.)

The export function will replace any "variables" it finds within the export template 
file with the current value of the variable.  Variables are pre-defined names enclosed 
between braces: {VariableName}.

Note:  The template examples shown below are included in the template file, 
“Example Export Template.btx”.

Any other text that is present in the template file will be exported "as is" unless it is 
part of a comment or other special template section.

{StartComment}

Any text present between {StartComment} and 
{EndComment} will not be saved to the export file.  
Comments can be used to annotate the template file.

{EndComment}

The lines between StartHeader and EndHeader will only be saved to a new export 
file.  They will not be saved when new results are appended to an existing export 
file. This can be used to create a column header for a summary list of results from 
multiple runs, for example.

{StartHeader}

Date, Name, Ret. Time, Area, Mole%

{EndHeader}

"DecimalPlaces" is a special variable used to set the number of decimal places to 
include for calculated results (4 places in this example).  It affects the results that are 
exported after its place in the template.  Note that the default value is the number of 
decimal places specified in the Data Files configuration.

Note:  It is generally best to change the number of decimal places to report using the 
option in the Data Files section of the BTU Calculator configuration editor rather 
than the “Decimal Places” variable.

{DecimalPlaces,4}

To create a comma-delimited export file, simply include commas between the fields 
you wish to separate.  In addition, if you want quotation marks to enclose text fields, 
simply include them in the template as shown below.

"CurrentDate", "{Now}"
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"SampleName", "{SampleName}"

"UserName", "{UserName}"

To create a tab-delimited file, simply use the tab key on your keyboard, or include 
the special tab variable, "Tab", between the fields you wish to separate as shown 
below.

CurrentDate {Now}

SampleName {SampleName}

UserName {UserName}

or

MethodName{Tab}{MethodName}

SettingsFile{Tab}{SettingsFile}

InjectionTime{Tab}{InjectionTime}

You can use the special component loop to print the component-specific results 
(Name, Mole%, Area, etc.) for all of the components in the current configuration.  
The components are exported in the same order that they appear in the configuration 
editor.

{StartCompLoop}

{CompName},{CompRT},{CompArea},{CompNormMolePct}

{EndCompLoop}

If instead, you want to export the results for a specific component, simply include the 
component number in the variable as shown below. Components are numbered in the 
order they appear in the configuration editor, starting with 1 for the first component.

Component 1 Name:  {CompName,1}

Component 1 Mole%: {CompNormMolePct,1}

You can use the special line continuation variable, "_", to force the next line in the 
template to be appended to the current line instead of in a new line:

{CompName,1},{_}

{CompName,2},{_}
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{CompName,3}

Line continuation is most useful in instances where you want all of the results to 
appear in a single line.  For example, you would use the line continuation in a 
component loop to create a summary export file in which each line corresponds to a 
single run.

{StartCompLoop}

{CompName},{CompRT},{CompArea},{CompNormMolePct},{_}

{EndCompLoop}

Summary of Export Template Variables

You can view a list of the variables that are supported by Export Templates at any 
time by selecting either the “Tools > Show Export Template Variables…” menu 
option, or by clicking on the “Show” button in the Export section of the 
configuration editor.  

BTU Calculator Template Variable Table

Hint: Hint:  If you double-click on a particular variable in the table, it will be copied to the 
Windows clipboard so that you can paste it into a template file.
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Export Variable Format Strings and Scale Factors

Optional formatting strings and scaling factors can be specified for export variables 
to increase flexibility.

Important: Important:  The use of formatting strings and scaling factors is an advanced feature 
and should only be utilized when export file requirements dictate.

The export variable syntax is shown below:

{VariableName, [PARAMETER], [FORMAT], [SCALEFACTOR]}

VariableName:  The name of the variable.

[PARAMETER]:  An optional parameter value that is required for some variables.

[FORMAT]:  A special format string that instructs the export engine on how to 
format the variable value before writing it to the export file.

[SCALEFACTOR]:  If the variable is numeric, it will be multiplied by the specified 
scaling factor prior to formatting and writing the result to the export file.

The following table describes the special characters used to make up a format string.

Format 
Character

Description

Numeric Formatting

0 Digit placeholder. Display a digit or a zero. If the variable has a digit in 
the position where the 0 appears in the format string, display it; otherwise, 
display a zero in that position.

# Digit placeholder. Display a digit or nothing. If the variable has a digit in 
the position where the # appears in the format string, display it; otherwise, 
display nothing in that position.

. Decimal placeholder.  The decimal placeholder determines how many 
digits are displayed to the left and right of the decimal separator. If the 
format expression contains only number signs to the left of this symbol, 
numbers smaller than 1 begin with a decimal separator. To display a 
leading zero displayed with fractional numbers, use 0 as the first digit 
placeholder to the left of the decimal separator.

Text String Formatting

@ Character placeholder. Display a character or a space. If the string has a 
character in the position where the “at” symbol (@) appears in the format 
string, display it; otherwise, display a space in that position.

& Character placeholder. Display a character or nothing. If the string has a 
character in the position where the ampersand (&) appears, display it; 
otherwise, display nothing.

Date Formatting

d Display the day as a number without a leading zero (1 – 31).

dd Display the day as a number with a leading zero (01 – 31).

m Display the month as a number without a leading zero (1 – 12).

mm Display the month as a number with a leading zero (01 – 12).

yy Display the year as a 2-digit number (00 – 99).

yyyy Display the year as a 4-digit number (100 – 9999).
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Time Formatting

h Display the hour as a number without leading zeros (0 – 23).

Hh Display the hour as a number with leading zeros (00 – 23).

N Display the minute as a number without leading zeros (0 – 59).

Nn Display the minute as a number with leading zeros (00 – 59).

S Display the second as a number without leading zeros (0 – 59).

Ss Display the second as a number with leading zeros (00 – 59).

The following table shows a few examples of format strings and scaling factors.

Variable Variable Value Value Exported

{CompRawMolePct,1,0.000} 1.523446 1.523

{CompRawMolePct,1,0.000} 85.67234 85.672

{CompRawMolePct,1,00000,1000} 85.67234 85672

{CompArea,2,00000000} 1234 00001234

{InjectionTime} 10/12/2004 1:08:13 PM 10/12/2004 1:08:13 PM

{InjectionTime,,mmddyyyy} 10/12/2004 1:08:13 PM 10122004

{InjectionTime,,HhNn} 10/12/2004 1:08:13 PM 2013

{SampleName,,@@@@@@@@} Sample Name Sample N

{SampleName,,@@@@@@@@} RC1 RC1*****

 * = a space character

Full List of Export Template Variables

The following table lists all of the variables that are support by the BTU Calculator’s 
Export Templates.

Hint: Hint:  The most up to date list of export template variables can always be viewed 
and printed by clicking the “Tools > Show Export Template Variables…” menu 
option.

Variable Description

Sample Information and Header Variables

{SampleName} The sample name as reported by the data 
system.

{Comments} Additional Sample Information or Sample 
Notes (from Cerity).

{SampleNotes} Same as {Comments}.

{MethodName} The Method used for acquisition by the 
data system.

{InjectionTime} The Date and Time of the injection as 
reported by the data system.

{DataFile} The data file to which the BTU results 
were saved.
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{SourceDataFilePath} The full path of the source data file used 
for acquisition by the data system.

{SourceDataFileName} The source data file used for acquisition by 
the data system.

{Instrument} The instrument name as reported by the 
data system.

{UserName} The user or operator name as reported by 
the data system.

{Operator} Same as {UserName}

{SettingsFile} The settings/configuration file used to 
calculate the results.

{SampleInfo, 1} Custom sample information field 1 as 
entered by the user.  Up to 10 sample 
information fields can be entered.  Change 
the numeric parameter to export results for 
a specific field.

{SampleInfoCaption, 1} The caption for custom sample information 
field 1 as set in the configuration file. Up 
to 4 custom sample information fields are 
supported.  Change the numeric parameter 
to export results for a specific field.

Component Variables

{CompNum} The current component number being 
processed in a component loop.

{CompName} The name of the current component being 
processed in a component loop.

{CompRawMolePct} The raw mole% as reported by the data 
system for the current component in a 
component loop.

{CompNormMolePct} The calculated normalized mole% for the 
current component in a component loop.

{CompRT} The retention time as reported by the data 
system for the current component in a 
component loop.

{CompArea} The peak area as reported by the data 
system for the current component in a 
component loop.

{CompHvFactor} The heating value calculation factor (Hv) 
from the current configuration file for the 
current component in a component loop.

{CompMMRatio} The molar mass ratio calculation factor (G) 
from the current configuration file for the 
current component in a component loop.

{CompSumFactor} The summation calculation factor (b) from 
the current configuration file for the 
current component in a component loop.

{CompGPMVolFactor} The volume property used to calculate the 
component GPM from the current 
configuration file for the current 
component in a component loop (cu. ft. 
ideal gas / gallon liquid).

{CompHeatingValue} The calculated heating value (Xi * Hvi) for 
the current component in a component 
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loop.

{CompRelDensity} The calculated relative denisty (Xi * Gi) 
for the current component in a component 
loop.

{CompCompressibility} The calculated compressibility (Xi * bi) for 
the current component in a component 
loop.

{CompGPM} The calculated GPM (Gal. per 1000 cu. ft.) 
for the current component in the 
component loop.

Miscellaneous Calculation Factors

{PressureBase} The pressure base used for the calculation.

{WaterVaporPressure} The water vapor pressure used for wet/sat 
calculations

{AirCompressibility} The air compressibility factor used for the 
calculations

{AirSumFactor} The air summation factor used for the 
calculations.

Calculated Results

{TotalRawMolePct} The calculated total raw mole%.

{TotalNormMolePct} The calculated total normalized mole% 
(should be 100%)

{SumHeatingValue} The calculated sum of component heating 
values (Sum Xi * Hvi).

{SumRelDensity} The calculated sum of component relative 
density values (Sum Xi * Gi).

{SumCompressibility} The calculated sum of component 
compressibility values (Sum Xi * bi).

{WaterMoleFractionSat} The mole fraction of water under saturated 
conditions.

{WaterMoleFractionWet} The mole fraction of water as entered by 
the user.

{GrossHvIdealDry} "The gross heating value calculated under 
ideal, dry conditions."

{GrossHvIdealSat} "The gross heating value calculated under 
ideal, saturated conditions."

{GrossHvIdealWet} "The gross heating value calculated under 
ideal, wet conditions."

{GrossHvRealDry} "The gross heating value calculated under 
real, dry conditions."

{GrossHvRealSat} "The gross heating value calculated under 
real, saturated conditions."

{GrossHvRealWet} "The gross heating value calculated under 
real, wet conditions."

{RealRelDensityDry} The real relative density calculated under 
dry conditions.

{RealRelDensitySat} The real relative density calculated under 
saturated conditions.

{RealRelDensityWet} The real relative density calculated under 
wet conditions.
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{GasCompressibilityDry} The gas compressibility calculated under 
dry conditions.

{GasCompressibilitySat} The gas compressibility calculated under 
saturated conditions.

{GasCompressibilityWet} The gas compressibility calculated under 
wet conditions.

{GPMTotal}, {SumGPM} The calculated sum of component GPM 
values.

Special Variables

{Tab} "The ASCII ""tab"" character."

{Now} The current date and time as reported by 
the operating system.

{StartCompLoop} Start a component processing loop.  All 
template lines between {StartCompLoop} 
and {EndCompLoop} will be repeated 
once for each component in the 
configuration.  Use the component loop to 
report component-specific results.

{EndCompLoop} End a component processing loop (see 
{StartCompLoop}

{StartHeader} All template lines between {StartHeader} 
and {EndHeader} will only be exported the 
first time an export file is written.  The 
header lines will not be written when 
additional results are appended to an 
exisitng export file.

{EndHeader} See {StartHeader}

{StartComment} Any text between {StartComment} and 
{EndComment} will not be exported.  Use 
to annotate your template file.

{EndComment} See {StartComment}

{UCase} Place on a line by itself to convert all 
subsequent export lines to upper case.

{LCase} Place on a line by itself to convert all 
subsequent export lines to lower case.

{NoCase} Place on a line by itself to report all 
subsequent export lines in their original 
case.

{DecimalPlaces,3} Place on a line by itself to set the number 
of decimal places that will be reported for 
calculated numeric results.  The default 
value is the number of decimal places 
specified in the Data Files configuration.

{_} Line continuation variable placed at the 
end of a line to force the next line in the 
template to be appended to the current line 
instead of to a new line.
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